Answers found here!

Excel 2007: The Missing Manual offers complete coverage of Excel’s dazzling new look and dramatically new way of doing things. With a unique and witty style that helps you learn quickly, this entertaining book doesn’t just explain how every feature works—it shows you which tools to use and which to avoid.

The important stuff you need to know

- Learn how to navigate Excel using the ribbon—the new tabbed toolbar.
- Create spreadsheets to track finances, schedules, and statistics.
- Perform simple or complex calculations with Excel’s formulas and functions.
- Search, sort, and filter huge lists of information.
- Tackle advanced data analysis—including pivot tables to help summarize information.
- Share your spreadsheets with the world and collaborate with others.
- Program Excel with timesaving macros and the Visual Basic scripting language.

People learn best when information is engaging, clearly written, and funny. Unfortunately, most computer books read like dry catalogs. That’s why I created the Missing Manuals. They’re entertaining, unafraid to state when a feature is useless or doesn’t work right, and—oh, by the way—written by actual writers. And on every page, we answer the simple question: “What’s this feature for?”

David Pogue is a New York Times technology columnist, bestselling author, and creator of the Missing Manual series.

Free online edition with purchase of this book. Details on last page.
Excel 2007

Matthew MacDonald
The Missing Credits ................................................................. xix
Introduction .................................................................................. 1

Part One: Worksheet Basics

Chapter 1: Creating and Navigating Worksheets ......................... 21
  Creating a Basic Worksheet .............................................................. 21
  Starting a New Workbook ............................................................ 23
  Adding the Column Titles ........................................................... 24
  Adding Data ................................................................................. 25
  Editing Data .................................................................................. 26
  Navigating in Excel ................................................................. 28
    The Tabs of the Ribbon ............................................................ 30
    The Formula Bar ..................................................................... 32
    The Status Bar ....................................................................... 33
    Excel Options .......................................................................... 37
  Saving Files ............................................................................ 38
    The Excel 2007 File Format .................................................. 39
    Saving Your Spreadsheet in Older Formats ......................... 41
    Saving Your Spreadsheet As a PDF ...................................... 45
    Saving Your Spreadsheet with a Password ....................... 47
    Disaster Recovery ................................................................. 49
  Opening Files ............................................................................. 51
    Opening Files—with a Twist .................................................. 53
    Opening Multiple Spreadsheets at Once .............................. 54
Chapter 2: Adding Information to Worksheets ......................... 57
  Adding Different Types of Data ................................................................. 57
  Controlling Your Data Types .................................................................. 60
  Quick Ways to Add Data .......................................................................... 64
    AutoComplete ......................................................................................... 65
    AutoCorrect ........................................................................................... 66
    AutoFill .................................................................................................. 67
    AutoFit .................................................................................................. 70
  Undo and Redo ......................................................................................... 72

Chapter 3: Moving Data Around a Worksheet............................... 75
  Selecting Cells ........................................................................................ 75
    Making Continuous Range Selections .................................................... 76
    Making Non-Contiguous Selections ....................................................... 79
    Automatically Selecting Your Data ....................................................... 79
    Making Selections with the Keyboard .................................................. 80
  Moving Cells Around ............................................................................ 82
    A Simple Cut-and-Paste or Copy-and-Paste ......................................... 82
    A Fancy Cut-and-Paste or Copy-and-Paste .......................................... 85
  The Clipboard ........................................................................................ 85
    Special Pasting ...................................................................................... 87
  Adding and Moving Columns or Rows ................................................... 90
    Inserting Columns ................................................................................ 91
    Inserting Rows ..................................................................................... 91
    Inserting Copied or Cut Cells ............................................................. 91
  Deleting Columns and Rows ................................................................. 93

Chapter 4: Managing Worksheets and Workbooks ..................... 95
  Worksheets and Workbooks ................................................................ 96
  Adding, Removing, and Hiding Worksheets ......................................... 97
  Naming and Rearranging Worksheets ................................................... 99
  Grouping Sheets .................................................................................... 100
  Moving Worksheets from One Workbook to Another .......................... 103
  Find and Replace ................................................................................... 105
    The Basic Find .................................................................................... 105
    Find All ............................................................................................... 107
    More Advanced Searches ................................................................... 108
  Finding Formatted Cells ...................................................................... 109
  Finding and Replacing Values ............................................................... 111
  Spell Check ........................................................................................... 113
  Spell Checking Options ......................................................................... 115

Chapter 5: Formatting Cells ......................................................... 119
  Formatting Cells .................................................................................... 120
    Formatting Numbers ............................................................................ 122
    Formatting Dates and Times .............................................................. 128
Chapter 6: Smart Formatting Tricks .............................................. 153
The Format Painter .............................................................................. 154
Styles and Themes ................................................................................. 154
  Custom Styles .................................................................................. 156
  Modifying Styles ............................................................................. 158
  Transferring Styles Between Workbooks ...................................... 159
  Themes: A Package of Styles .......................................................... 160
  Modifying Themes .......................................................................... 163
Conditional Formatting ........................................................................ 166
  The Basics of Conditional Formatting .......................................... 167
  Highlighting Specific Values ......................................................... 167
  Data Bars .......................................................................................... 172
  Color Scales .................................................................................. 173
  Icon Sets ......................................................................................... 174
  Fine-Tuning a Formatting Rule ..................................................... 175
  Using Multiple Rules .................................................................... 180

Chapter 7: Viewing and Printing Worksheets................................. 185
Controlling Your View .......................................................................... 185
  Zooming ......................................................................................... 186
  Viewing Distant Parts of a Spreadsheet at Once ............................. 188
  Freezing Columns or Rows ............................................................ 191
  Hiding Data ................................................................................. 193
  Saving View Settings .................................................................... 195
  Viewing Multiple Workbooks at Once ......................................... 197
Printing .............................................................................................. 199
  How to Print an Excel File ............................................................. 200
  Quick Printing .............................................................................. 202
  Previewing Your Printout .............................................................. 202
  Creating Headers and Footers ....................................................... 205
  Customizing Print Settings ............................................................ 207
Controlling Pagination ....................................................................... 212
  Page Breaks .................................................................................. 212
  Scaling ......................................................................................... 213
  Page Break Preview: A Bird’s-Eye View of Your Worksheet .......... 214
Part Two: Formulas and Functions

Chapter 8: Building Basic Formulas ...................................................... 219
  Creating a Basic Formula ...................................................................................................................... 219
  Excel’s Order of Operations ........................................................................................................... 221
  Cell References ......................................................................................................................................... 223
  How Excel Formats Cells That Contain Cell References ............................................................. 225
  Functions ........................................................................................................................................... 225
  Formula Errors ....................................................................................................................................... 231
  Logical Operators ..................................................................................................................................... 233
  Formula Shortcuts .................................................................................................................................. 236
  Point-and-Click Formula Creation ................................................................................................. 236
  Point-and-Click Formula Editing .................................................................................................... 237
  The Formulas Tab .................................................................................................................................... 237
  Using the Insert Function Button ................................................................................................... 239
  Copying Formulas .................................................................................................................................. 243
  Absolute Cell References ................................................................................................................ 245
  Partially Fixed References ............................................................................................................... 247
  Referring to Other Worksheets and Workbooks ............................................................................. 248

Chapter 9: Math and Statistical Functions ............................................ 253
  Rounding Numbers ............................................................................................................................. 253
    ROUND(), ROUNDDOWN(), ROUNDUP(): Rounding Numbers .................................................. 254
    MROUND(), CEILING(), and FLOOR(): More Rounding Functions ........................................ 255
    INT() and TRUNC(): Chopping Off Non-Whole Numbers ......................................................... 257
    EVEN() and ODD(): Rounding Up to Even or Odd Values ....................................................... 258
  Groups of Numbers ............................................................................................................................... 259
    SUM(): Summing Up Numbers ..................................................................................................... 259
    COUNT(), COUNTA(), and COUNTBLANK(): Counting Items in a List ..................................... 260
    MAX() and MIN(): Finding Maximum and Minimum Values ................................................... 262
    LARGE(), SMALL(), and RANK(): Ranking Your Numbers .................................................... 263
    AVERAGE() and MEDIAN(): Finding Average or Median Values ........................................... 264
    MODE(): Finding Numbers That Frequently Occur in a List ..................................................... 265
    PERCENTILE() and PERCENTRANK(): Advanced Ranking Functions ...................................... 266
    FREQUENCY(): Identifying to Which Category a Number Belongs ........................................... 267
  General Math Functions ........................................................................................................................ 269
    PRODUCT(), FACT(), POWER(), and SQRT(): Products, Factorials, Powers, and Square Roots ..................... 270
    QUOTIENT() and MOD(): Higher Division ..................................................................................... 271
    ABS() and SIGN(): Absolute Value and Determining a Number’s Sign .................................... 272
    RAND() and RANDBETWEEN(): Generating Random Numbers ............................................... 272
    GCD() and LCM(): Greatest and Least Common Denominator .................................................... 275
    COMBIN() and PERMUT(): Figuring Combinations and Permutations ........................................ 275
  Trigonometry and Advanced Math ...................................................................................................... 276
  Advanced Statistics ............................................................................................................................ 279
# Table of Contents

## Chapter 10: Financial Functions

- The World of Finance ........................................................................................................ 285
- Financial Functions ............................................................................................................. 286
  - FV( ): Future Value ........................................................................................................... 287
  - PV( ): Present Value ......................................................................................................... 290
  - PMT( ), PPMT( ), and IPMT( ): Calculating the Number of Payments You Need to Make .... 292
  - NPER( ): Figuring Out How Much Time You'll Need to Pay Off a Loan or Meet an Investment Target ....................................................................................................................... 295
  - RATE( ): Figuring the Interest Rate You Need to Achieve Future Value ......................... 295
  - NPV( ) and IRR( ): Net Present Value and Internal Rate of Return ................................. 296
- Depreciation ....................................................................................................................... 299
- Other Financial Functions .................................................................................................. 303

## Chapter 11: Manipulating Dates, Times, and Text

- Manipulating Text ................................................................................................................ 305
  - CONCATENATE( ): Joining Strings of Text Together ............................................................ 306
  - LEFT( ), MID( ), and RIGHT( ): Copying Portions of a Text String ........................................ 306
  - LEN( ), FIND( ), and SEARCH( ): Counting Characters in a String .................................... 307
  - UPPER( ), LOWER( ), and PROPER( ): Changing Capitalization ......................................... 309
  - TRIM( ) and CLEAN( ): Removing Unwanted Spaces and Non-Printing Characters .......... 310
  - SUBSTITUTE( ): Replacing One Sequence of Characters with Another ............................. 311
  - TEXT( ), VALUE( ), FIXED( ), and DOLLAR( ): Converting Text to Numbers and Vice Versa .... 311
  - Other Text Functions ........................................................................................................ 313
- Manipulating Dates and Times .......................................................................................... 314
- Math with Dates and Times ............................................................................................... 316
- Using Dates and Times with Ordinary Functions ............................................................. 316
- Date and Time Functions .................................................................................................... 317
  - TODAY( ) and NOW( ): Inserting the Current Date and Time .............................................. 317
  - DATE( ) and TIME( ): Dates and Times in Calculations ..................................................... 318
  - DAY( ), MONTH( ), and YEAR( ): More Date Calculations ................................................ 320
  - HOUR( ), MINUTE( ), SECOND( ): More Time Calculations ............................................. 321
  - WEEKDAY( ): Determining the Day of the Week ............................................................... 322
  - DATEDIFF( ): Calculating the Difference Between Dates .................................................. 322
  - DATEVALUE( ) and TIMEVALUE( ): Converting Dates and Times into Serial Numbers .......... 324
  - DAYS360( ): Finding Out the Number of Days Between Two Dates .................................. 326
  - EDATE( ): Calculating Future Dates .................................................................................. 326
  - YEARFRAC( ): Calculating the Percentage of a Year Between Two Dates .......................... 327
  - EOMONTH( ): Finding the Last Day of Any Month ........................................................... 328
  - NETWORKDAYS( ): Counting the Number of Business Days ........................................... 328
  - WORKDAY( ): Figuring Out When Days Will Fall in the Future ....................................... 329
  - WEEKNUM( ): Figuring Out in Which Week a Date Falls .................................................. 329
Chapter 12: Lookup, Reference, and Information Functions .............. 331

The Basic Lookup ......................................................................................................................... 332
  VLOOKUP(): Vertical Lookups ................................................................................................... 333
  HLOOKUP(): Horizontal Lookups ............................................................................................. 335

Advanced Lookups .......................................................................................................................... 336
  MATCH(): Finding the Position of Items in a Range ................................................................. 337
  INDEX(): Retrieving the Value from a Cell ................................................................................ 338
  Performing a "Left Lookup" ....................................................................................................... 338
  Performing a Double Lookup .................................................................................................... 340
  The Lookup Wizard .................................................................................................................. 341
  OFFSET(): Moving Cell References to a New Location ............................................................. 344

Other Reference and Lookup Functions ....................................................................................... 345
  INDIRECT() and ADDRESS(): Working with Cell References Stored As Text ....................... 345
  TRANSPOSE(): Changing Rows into Columns and Vice Versa ................................................. 348

Information Functions ..................................................................................................................... 350
  The "IS" Functions: Checking the Value Inside a Cell .............................................................. 350
  TYPE() and ERROR.TYPE(): Finding a Value’s Data Type or Error Type ............................... 352
  INFO() and CELL(): Gathering Info About Your Computer and Your Worksheet’s Cells .......... 352

Tutorial: Quickly Generating Invoices from a Product Catalog .................................................. 354

Chapter 13: Advanced Formula Writing and Troubleshooting ...........357

Conditions in Formulas .................................................................................................................... 357
  IF(): Building Conditional Formulas .......................................................................................... 358
  COUNTIF(): Counting Only the Cells You Specify ................................................................. 359
  SUMIF(): Adding Only the Cells You Specify ............................................................................ 362
  COUNTIFS() and SUMIFS(): Counting and Summing Using Multiple Criteria ....................... 363

Descriptive Names for Cell References ......................................................................................... 365
  Creating and Using a Named Range ........................................................................................... 366
  Creating Slightly Smarter Named Ranges .................................................................................. 368
  Naming Formulas and Constants ............................................................................................... 369
  Managing Named Ranges .......................................................................................................... 370
  Automatically Creating Named Ranges .................................................................................... 372
  Applying Names to Existing Formulas ...................................................................................... 374

Variable Data Tables ....................................................................................................................... 376
  Creating a One-Variable Data Table .......................................................................................... 377
  Creating a Two-Variable Data Table .......................................................................................... 378

Controlling Recalculation ............................................................................................................... 380

Solving Formula Errors ................................................................................................................ 381
  Step-by-Step Evaluation ............................................................................................................ 382
  Tracing Precedents and Dependents ......................................................................................... 384
  Error Checking ........................................................................................................................... 387
Part Three: Organizing Worksheets

Chapter 14: Tables: List Management Made Easy ........................................... 393
   The Basics of Tables .......................................................................................... 394
   Creating a Table .................................................................................................. 394
   Formatting a Table .............................................................................................. 396
   Editing a Table .................................................................................................... 400
   Selecting Parts of a Table .................................................................................. 402
   Sorting and Filtering a Table .............................................................................. 403
      Applying a Simple Sort Order ......................................................................... 404
      Sorting with Multiple Criteria ......................................................................... 405
      Sorting by Color ............................................................................................... 409
      Filtering with the List of Values ...................................................................... 410
      Creating Smarter Filters .................................................................................. 412
   Dealing with Duplicate Rows .............................................................................. 414
      Highlighting Duplicates .................................................................................... 414
      Removing Duplicates Automatically ................................................................. 415
   Performing Table Calculations .......................................................................... 417
      Dynamic Calculations ...................................................................................... 417
      Column Names .................................................................................................. 419
      Table Names ..................................................................................................... 420
      The Total Row ................................................................................................... 421
      The SUBTOTAL() Function .............................................................................. 422
      The Database Functions ................................................................................... 424

Chapter 15: Grouping and Outlining Data ....................................................... 427
   Basic Data Grouping .......................................................................................... 427
   Creating a Group ................................................................................................. 428
   Nesting Groups Within Groups .......................................................................... 432
   Summarizing Your Data ...................................................................................... 434
   Combining Data from Multiple Tables .............................................................. 435
   Grouping Timesavers .......................................................................................... 439
      Auto Outline ..................................................................................................... 439
      Automatic Subtotaling .................................................................................... 440

Chapter 16: Templates ....................................................................................... 443
   Understanding Templates .................................................................................... 444
   Creating a New Workbook from a Template .................................................... 445
      Downloading Templates (Method 1: The New Workbook Dialog Box) .......... 446
      Downloading Templates (Method 2: The Office Online Web Site) ................. 448
   Creating Templates ............................................................................................ 452
      Understanding Custom Templates ................................................................... 452
      Building a Custom Template .......................................................................... 454
      Sharing Templates with Others ....................................................................... 456
Part Four: Charts and Graphics

Chapter 17: Creating Basic Charts ......................................................... 463
  Charting 101 .......................................................................................... 464
  Embedded and Standalone Charts ..................................................... 465
  Creating a Chart with the Ribbon ....................................................... 466
  The Chart Tools Ribbon Tabs ............................................................. 467
  Basic Tasks with Charts ..................................................................... 468
  Moving and Resizing a Chart ............................................................. 468
  Creating a Standalone Chart ............................................................. 471
  Editing and Adding to Chart Data ................................................... 472
  Changing the Chart Type ................................................................... 473
  Printing Charts .................................................................................. 473
  Practical Charting .............................................................................. 475
  Charts with Multiple Series of Numbers ......................................... 475
  Controlling the Data Excel Plots on the X-Axis ............................... 475
  Data That Uses a Date or Time Scale ............................................... 478
  Non-Contiguous Chart Ranges ......................................................... 481
  Changing the Order of Your Data Series ......................................... 483
  Changing the Way Excel Plots Blank Values .................................... 483
  Chart Types ...................................................................................... 484
    Column ............................................................................................ 484
    Bar ................................................................................................. 486
    Line ............................................................................................... 486
    Pie ................................................................................................. 488
    Area ............................................................................................... 488
    XY (Scatter) .................................................................................. 489
    Stock ............................................................................................. 491
    Surface .......................................................................................... 491
    Donut ............................................................................................ 493
    Bubble ........................................................................................... 494
    Radar ............................................................................................. 494

Chapter 18: Formatting and Perfecting Charts ................................. 497
  Chart Styles and Layouts ................................................................. 497
    Chart Styles .................................................................................. 498
    Chart Layouts ............................................................................... 499
  Adding Chart Elements ................................................................. 499
    Adding Titles ................................................................................. 501
    Adding a Legend ........................................................................... 502
    Adding Data Labels to a Series ................................................... 503
    Adding Individual Data Labels .................................................... 506
    Adding a Data Table ...................................................................... 508
  Selecting Chart Elements ............................................................... 508

<table>
<thead>
<tr>
<th>Format and Design Options</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Formatting Chart Elements</td>
<td>510</td>
</tr>
<tr>
<td>Coloring the Background</td>
<td>510</td>
</tr>
<tr>
<td>Fancy Fills</td>
<td>512</td>
</tr>
<tr>
<td>Fancy Borders and Lines</td>
<td>515</td>
</tr>
<tr>
<td>Formatting Data Series and Data Points</td>
<td>517</td>
</tr>
<tr>
<td>Reusing Your Favorite Charts with Templates</td>
<td>519</td>
</tr>
<tr>
<td>Improving Your Charts</td>
<td>520</td>
</tr>
<tr>
<td>Controlling a Chart’s Scale</td>
<td>520</td>
</tr>
<tr>
<td>Adding a Trendline</td>
<td>524</td>
</tr>
<tr>
<td>Adding Error Bars to Scientific Data</td>
<td>526</td>
</tr>
<tr>
<td>Formatting 3-D Charts</td>
<td>528</td>
</tr>
<tr>
<td>Changing the Shape of a 3-D Column</td>
<td>530</td>
</tr>
<tr>
<td>Advanced Charting</td>
<td>531</td>
</tr>
<tr>
<td>Exploding Slices in a Pie</td>
<td>531</td>
</tr>
<tr>
<td>Grouping Slices in a Pie</td>
<td>531</td>
</tr>
<tr>
<td>Gaps, Widths, and Overlays in a Column Chart</td>
<td>533</td>
</tr>
<tr>
<td>Creating Combination Charts</td>
<td>534</td>
</tr>
<tr>
<td>Part Five: Advanced Data Analysis</td>
<td></td>
</tr>
<tr>
<td>Chapter 20: Scenarios and Goal Seeking</td>
<td>571</td>
</tr>
<tr>
<td>Using Scenarios</td>
<td>572</td>
</tr>
<tr>
<td>Creating a New Scenario</td>
<td>572</td>
</tr>
<tr>
<td>Managing Scenarios</td>
<td>575</td>
</tr>
<tr>
<td>Creating a Summary Report</td>
<td>576</td>
</tr>
<tr>
<td>Using Goal Seek</td>
<td>578</td>
</tr>
<tr>
<td>Goal Seeking with Complex Equations</td>
<td>580</td>
</tr>
</tbody>
</table>
Chapter 26: Connecting Worksheets to the Web ................................. 725
Putting Worksheets on the Web .......................................................... 725
Saving an HTML File ......................................................................... 726
Performing Web Queries ................................................................. 731
The Limitations of Web Queries ....................................................... 731
Creating a Web Query ...................................................................... 732
The Research Pane—a Web Query Alternative .............................. 735
Using Hyperlinks .............................................................................. 736
Adding a Hyperlink to a Web Page or Document ............................. 737
Adding a Hyperlink to a Worksheet Location .................................. 739
The HYPERLINK( ) Function: Creating a Link on Your Own .......... 740

Part Seven: Programming Excel

Chapter 27: Automating Tasks with Macros ................................. 745
Macros 101 ....................................................................................... 745
Macro-Free and Macro-Enabled Workbooks .................................. 747
The Macro Recorder ......................................................................... 748
Relative and Absolute Recording ..................................................... 748
Where Macros Live ......................................................................... 749
Recording a Macro .......................................................................... 751
Playing a Macro ............................................................................... 753
Macro Security ................................................................................ 755
The Trust Center ............................................................................. 757
Setting Up a Trusted Location ......................................................... 759
Creating Practical Macros ............................................................... 761
Inserting a Header .......................................................................... 761
Alternating Row Formatting ............................................................ 762
A Combined Task .......................................................................... 764
Placing a Macro on the Quick Access Toolbar .............................. 765
Attaching a Macro to a Button Inside a Worksheet ....................... 767

Chapter 28: Programming Spreadsheets with VBA ...................... 771
The Visual Basic Editor .................................................................... 772
The Project Window ......................................................................... 772
Modules and Macros ....................................................................... 774
Finding and Editing Macros .............................................................. 775
Debugging a Macro .......................................................................... 776
The Missing Credits

About the Author


About the Creative Team

Peter Meyers (editor) works as an editor at O’Reilly Media on the Missing Manual series. He lives with his wife and cats in New York City. Email: peter.meyers@gmail.com.

Rhea Howard (technical reviewer) works in the Operations department at O’Reilly Media and is an avid Excel user. She currently splits her time between Sebastopol and San Francisco, CA.

Zack Barresse (technical reviewer) started teaching himself Excel in 2003 and fast became an addict. In October 2005, he was awarded the Microsoft MVP award for Excel. Along with Jake Hilderbrand, he owns www.VBAeXpress.com, a site dedicated to VBA. His full-time gig is as an ambulance EMT. Zack’s a family man and a volunteer lieutenant with his local fire department.

Sohaila Abdulali (copy editor) is a freelance writer and editor. She has published a novel, several children’s books, and numerous short stories and articles. She recently finished an ethnography of an aboriginal Indian woman. She lives in New York City with her husband, Tom, and their small but larger-than-life daughter, Samara. She can be reached through her web site at www.sohailaink.com.

Acknowledgements

Writing a book about a program as sprawling and complex as Excel is a labor of love (love of pain, that is). I’m deeply indebted to a whole host of people, including those who helped me track down all the neat and nifty things you can do with the latest version of Office (including bloggers extraordinaire David Gainer and Jensen Harris), those who kept the book clear, concise, and technically accurate (Peter Meyers, Sarah Milstein, Zack Barresse, and Rhea Howard), and those who put up with me while I wrote it (more on that in a moment). I also owe thanks to many people who worked to get this book formatted, indexed, and printed.
Completing this book required a few sleepless nights (and many sleep-deprived days). I extend my love and thanks to my daughter, Maya, who put up with it without crying most of the time; my dear wife Faria, who mostly did the same; and our moms and dads (Nora, Razia, Paul, and Hamid), who contributed hours of babysitting, tasty meals, and general help around the house that kept this book on track. So thanks everyone—without you, half of the book would still be trapped inside my brain!

**The Missing Manual Series**

Missing Manuals are witty, superbly written guides to computer products that don’t come with printed manuals (which is just about all of them). Each book features a handcrafted index and RepKover, a detached-spine binding that lets the book lie perfectly flat without the assistance of weights or cinder blocks.

Recent and upcoming titles include:

- *CSS: The Missing Manual* by David Sawyer McFarland
- *Creating Web Sites: The Missing Manual* by Matthew MacDonald
- *Dreamweaver 8: The Missing Manual* by David Sawyer McFarland
- *eBay: The Missing Manual* by Nancy Conner
- *FileMaker Pro 8: The Missing Manual* by Geoff Coffey and Susan Prosser
- *GarageBand 2: The Missing Manual* by David Pogue
iMovie HD 6: The Missing Manual by David Pogue
iPhoto 6: The Missing Manual by David Pogue
PCs: The Missing Manual by Andy Rathbone
Photoshop Elements 5: The Missing Manual by Barbara Brundage
Quicken for Starters: The Missing Manual by Bonnie Biafore
Switching to the Mac: The Missing Manual, Tiger Edition by David Pogue and Adam Goldstein
The Internet: The Missing Manual by David Pogue and J.D. Biersdorfer
Windows XP for Starters: The Missing Manual by David Pogue
Windows Vista: The Missing Manual by David Pogue
Windows Vista for Starters: The Missing Manual by David Pogue
Introduction

Most people don’t need much convincing to use Excel, Microsoft’s premier spreadsheet software. In fact, the program comes preinstalled on a lot of computers, making it the obvious choice for millions of number crunchers. Despite its wide use, however, few people know where to find Excel’s most impressive features or why they’d want to use them in the first place. *Excel 2007: The Missing Manual* fills that void, explaining everything from basic Excel concepts to fancy tricks of the trade.

This book teaches you not only how the program works, it also shows you how to use Excel’s tools to answer real-world questions like “How many workdays are there between today and my vacation?”, “How much money do I need in the bank right now to retire a millionaire?”, and “Statistically speaking, who’s smarter—Democrats or Republicans?” Best of all, you’ll steer clear of obscure options that aren’t worth the trouble to learn, while homing in on the hidden gems that’ll win you the undying adoration of your coworkers, your family, and your friends—or at least your accountant.

*Note:* This book is written with Microsoft’s latest and greatest release in mind: Excel 2007. This book won’t help you if you’re using an earlier version of Excel, because Microsoft has dramatically changed Excel’s user interface (the “look and feel” of the program). However, if you’re an unredeemed Excel 2003 or Excel 2002 fanatic, you can get help from the previous edition of this book, which is simply named *Excel 2003: The Missing Manual*. The Mac version of Excel is covered in *Office 2004 for Macintosh: The Missing Manual*. 
**Introduction**

**What You Can Do with Excel**

Excel and Word are the two powerhouses of the Microsoft Office family. While Word lets you create and edit documents, Excel specializes in letting you create, edit, and analyze data that’s organized into lists or tables. This grid-like arrangement of information is called a spreadsheet. Figure I-1 shows an example.

**Frequently Asked Question**

**Is That 2,007 or 2007?**

What do Excel’s version numbers mean?

Most people realize that the “2007” in Excel 2007 indicates the year, not the 2,007th release of the software. Microsoft’s on-again, off-again naming policy is to leave the actual version number out of product names. So what version is Excel 2007?

If you dig around a little (select Office Button ➔ Excel Options, and then, in the list, choose the Resources section), you’ll discover that Excel 2007 is actually Excel Version 12. But even this version number doesn’t mean what you might expect. Excel 12 is actually the tenth release of Excel on the Windows platform. The first version of Excel was a Macintosh-only release, and there is no Excel 6. The reason? Microsoft felt the change in software that ran on Windows 3.x to that which ran on Windows 95 was so great they were entitled to jump up two version numbers at once. (As questionable as that sounds, it’s a technique nearly all software makers use at some point.)

Some common spreadsheets include:

- **Business documents** like financial statements, invoices, expense reports, and earnings statements.

- **Personal documents** like weekly budgets, catalogs of your *Star Wars* action figures, exercise logs, and shopping lists.

- **Scientific data** like experimental observations, models, and medical charts.

These examples just scratch the surface. Resourceful spreadsheet gurus use Excel to build everything from cross-country trip itineraries to logs of every Kevin Bacon movie they've ever seen.

Of course, Excel really shines in its ability to help you analyze a spreadsheet’s data. For example, once you’ve entered a list of household expenses, you can start crunching numbers with Excel’s slick formula tools. Before long you’ll have totals, subtotals, monthly averages, a complete breakdown of cost by category, and maybe even some predictions for the future: Excel can help track your investments and tell you how long until you’ll have saved enough to buy that weekend house in Vegas.

The bottom line is that once you enter raw information, Excel’s built-in smarts can help compute all kinds of useful figures. Figure I-2 shows a sophisticated spreadsheet that’s been configured to help identify hot-selling product categories.

---

**Figure I-2:** This spreadsheet summarizes a company’s total sales. The information’s grouped based on where the company’s customers live, and it’s further divided according to product category. Summaries like these can help you spot profitable product categories and identify items popular in specific cities. This advanced example uses pivot tables, which are described in Chapter 21.
Note: Keen eyes will notice that neither of these examples (Figure I-1 and Figure I-2) include the omnipresent Excel ribbon, which usually sits atop the window, stacked with buttons. That’s because it’s been collapsed neatly out of the way to let you focus on the spreadsheet. You’ll learn how to use this trick yourself on page 31.

Excel’s not just a math wizard. If you want to add a little life to your data, you can inject color, apply exotic fonts, and even create macros (automated sequences of steps) to help speed up repetitive formatting or editing chores. And if you’re bleary-eyed from staring at rows and rows of spreadsheet numbers, you can use Excel’s many chart-making tools to build everything from 3-D pie charts to more exotic scatter graphs. (See Chapter 17 to learn about all of Excel’s chart types.) Excel can be as simple or as sophisticated as you want it to be.

Excel’s New Face

Although Microsoft’s reluctant to admit it, most of Excel’s core features were completed nearly 10 years ago. So what has Microsoft been doing ever since? The answer, at least in part, is spending millions of dollars on usability tests, which are aimed at figuring out how easy—or not—a program is to use. In a typical usability test, Microsoft gathers a group of spreadsheet novices, watches them fumble around with the latest version of Excel, and then tweaks the program to make it more intuitive.

After producing Excel 2003, Microsoft finally decided that minor tune-ups couldn’t fix Excel’s overly complex, button-heavy toolbars. So they decided to start over. The result is a radically redesigned user interface that actually makes sense. The centerpiece of this redesign is the super-toolbar called the ribbon.

The Ribbon

Everything you’ll ever want to do in Excel—from picking a fancy background color to pulling information out of a database—is packed into the ribbon. To accommodate all these buttons without becoming an over-stuffed turkey, the ribbon uses tabs. Excel starts out with seven tabs in the ribbon. When you click one of these tabs, you see a whole new collection of buttons (Figure I-3).

Tip: Wondering what each tab holds? You’ll take a tab tour in Chapter 1 on page 30.

The ribbon is the best thing to hit the Excel scene in years. The ribbon makes it easier to find features and remember where they are, because each feature is grouped into a logically related tab. Even better, once you find the button you need you can often find other, associated commands by looking at the section where the button is placed. In other words, the ribbon isn’t just a convenient tool—it’s also a great way to explore Excel.
The ribbon is full of craftsmanship-like detail. For example, when you hover over a button, you don’t see a paltry two- or three-word description in a yellow box. Instead, you see a friendly pop-up box with a complete mini-description and a shortcut that lets you trigger this command from the keyboard. Another nice detail is the way you can jump through the tabs at high velocity by positioning the mouse pointer over the ribbon and rolling the scroll wheel (if your mouse has a scroll wheel). And you’re sure to notice the way the ribbon rearranges itself to fit the available space in the Excel window (see Figure I-4).

**Using the Ribbon with the Keyboard**

If you’re an unredeemed keyboard lover, you’ll be happy to hear that you can trigger ribbon commands with the keyboard. The trick is using *keyboard accelerators*, a series of keystrokes that starts with the Alt key (the same key you used to use to get to a menu). When using a keyboard accelerator, you *don’t* hold down all the keys at the same time. (As you’ll soon see, some of these keystrokes contain so many letters that you’d be playing Finger Twister if you tried holding them all down simultaneously.) Instead, you hit the keys one after the other.

The trick to using keyboard accelerators is to understand that once you hit the Alt key, there are two things you do, in this order:

1. Pick the ribbon tab you want.
2. Choose a command in that tab.

Before you can trigger a specific command, you *must* select the correct tab (even if it’s already displayed). Every accelerator requires at least two key presses after you hit the Alt key. You need even more if you need to dig through a submenu.

By now, this whole process may seem overly impractical. Are you really expected to memorize dozens of different accelerator key combinations?
Fortunately, Excel is ready to help you out with a new feature called KeyTips. Here’s how it works. Once you press the Alt key, letters magically appear over every tab in the ribbon. Once you hit a key to pick a tab, letters appear over every button in that tab (Figure I-5). You can then press the corresponding key to trigger the command (Figure I-6).

**Figure I-4:**
Top: A large Excel window gives you plenty of room to play. The ribbon uses the space effectively, making the most important buttons bigger.

Bottom: When you shrink the Excel window, the ribbon rearranges its buttons and makes some smaller (by shrinking the button’s icon or leaving out the title). Shrink small enough, and you might run out of space for a section altogether. In that case, you get a single button (like the Number, Styles, and Cells sections in this example) for an entire section. Click this button and the missing commands appear in a drop-down panel.

**Figure I-5:**
When you press Alt, Excel helps you out with KeyTips next to every tab, over the Office menu, and over the buttons in the Quick Access toolbar. If you follow up with M (for the Formulas tab), you’ll see letters next to every command in that tab, as shown in Figure I-6.
In some cases, a command might have two letters, in which case you need to press both keys, one after the other. (For example, the Find & Select button on the Home tab has the letters FD. To trigger it, press Alt, then H, then F, and then D.)

**Tip:** You can back out of KeyTips mode without triggering a command at any time by pressing the Alt key again.

There are other shortcut keys that don’t use the ribbon. These are key combinations that start with the Ctrl key. For example, Ctrl+C copies highlighted text and Ctrl+S saves your work. Usually, you find out about a shortcut key by hovering over a command with the mouse. For example, hover over the Paste button in the ribbon’s Home tab, and you see a tooltip that tells you its timesaving shortcut key is Ctrl+V. And if you’ve worked with a previous version of Excel, you’ll find that Excel 2007 keeps most of the same shortcut keys.

**The Office Menu**

There’s still one small part of the traditional Excel menu system left in Excel 2007—sort of. The traditional File menu that lets you open, save, and print files has been transformed into the **Office menu**. You get there using the Office button, which is the big round logo in the top-left corner of the window (Figure I-8).

The Office menu is generally used for three things:

- Working with files (creating, opening, closing, and saving them). You’ll do plenty of this in Chapter 1.

- Printing your work (Chapter 7) and sending it off to other people by email (Chapter 23).

- Configuring how Excel behaves. Choose Excel Options at the bottom of the menu to get to the Excel Options dialog box, an all-in-one place for configuring Excel (page 37).
There’s one menu quirk that takes a bit of getting used to. Some menu commands hide submenus that have more commands. Take for instance the Print command. From the Office menu, you can choose Print to fire off a quick printout of your work. But if you click the right-pointing arrow at the edge of the Print command (or if you hover over it for a moment), you see a submenu with more options, as shown in Figure I-9.

**Figure I-7:** By pressing Alt+E, you’ve triggered the “imaginary” Edit menu from Excel 2003, and earlier versions. You can’t actually see it (because in Excel 2007 this menu doesn’t exist). However, the tooltip lets you know that Excel is paying attention. You can now complete your action by pressing the next key for the menu command you’re nostalgic for.

There’s one menu quirk that takes a bit of getting used to. Some menu commands hide submenus that have more commands. Take for instance the Print command. From the Office menu, you can choose Print to fire off a quick printout of your work. But if you click the right-pointing arrow at the edge of the Print command (or if you hover over it for a moment), you see a submenu with more options, as shown in Figure I-9.

**Figure I-7:** By pressing Alt+E, you’ve triggered the “imaginary” Edit menu from Excel 2003, and earlier versions. You can’t actually see it (because in Excel 2007 this menu doesn’t exist). However, the tooltip lets you know that Excel is paying attention. You can now complete your action by pressing the next key for the menu command you’re nostalgic for.
Figure I-8: The Office menu is bigger and easier to read than a traditional menu. It also has a list of the documents you used recently on the right side. (You’ll learn about this wildly useful feature on page 52.)

Figure I-9: Print is both a clickable menu command and holder of a submenu. To see the submenu, you need to hover over Print (without clicking) or click the arrow at the right edge (shown here). The ribbon also has a few buttons that work this way.
The Quick Access Toolbar

Keen eyes will have noticed the tiny bit of screen real estate that sits on the right side of the Office button, just above the ribbon. It holds a series of tiny icons, like the toolbars in older versions of Excel (Figure I-10). This is the Quick Access toolbar (or QAT to Excel nerds).

If the Quick Access toolbar was nothing but a specialized shortcut for three commands, it wouldn’t be worth the bother. However, the nifty thing about the Quick Access toolbar is that you can customize it. In other words, you can remove commands you don’t use and add your own favorites. The Appendix shows how.

Microsoft has deliberately kept the Quick Access toolbar very small. It’s designed to provide a carefully controlled outlet for those customization urges. Even if you go wild stocking the Quick Access toolbar with your own commands, the rest of the ribbon remains unchanged. (And that means a coworker or spouse can still use your computer without suffering a migraine.)

Excel’s New Features

The slick new ribbon is Excel’s most dramatic change, but it’s not the only new feature in Excel 2007. Other hot additions include:

• **Fewer limits.** Excel worksheets can now be bigger, formulas can be more complex, and cells can hold way more text. Although 99.87 percent of Excel fans never ran into any of these limits in previous versions, it’s nice to know that the Excel engine continues to get more powerful.

• **Faster speed.** One of the newest pieces of computing hardware is a dual core CPU. (The CPU is the brain of any computer.) A dual core CPU can perform two tasks at once. The problem is, if you work with software that knows how to
advantage of the way it works. Excel 2007 knows all about dual core CPUs, which means intense calculations are even faster on these computers.

- **Better-looking charts.** Excel charts have always been intelligent, but they’ve never made good eye candy. Excel 2007 shakes things up with a whole new graphics engine that lets you add fantastic looking charts, diagrams, and shapes to your spreadsheets. You can even throw in fancy effects like textures, shadows, and three-dimensional text. Part 4 deals with chapters and graphics.

- **Formula AutoComplete.** The latest in a whole bunch of auto-do-something features, formula AutoComplete just might be the most helpful innovation yet. It prompts you with possible values when you type in complex formulas. You’ll learn how it works in Chapter 8.

- **Tables.** When Microsoft created Excel 2003, they added a wildly popular list feature that helped people manage lists of information. In Excel 2007, lists morph into tables and get even more powerful. Chapter 14 has all the details.

- **Easier (and prettier) conditional formatting.** Every spreadsheet designer wants to make sure important information stands out. Previous Excel versions had a conditional formatting feature to help out, but it was mind-numbingly difficult to use. In Excel 2007, conditional formatting gets much easier and picks up a few new frills—like a way to highlight values with shaded bars and tiny icons. You’ll get the scoop in Chapter 6.

- **Easier (and prettier) pivot tables.** Pivot tables are one of the hidden gems in Excel. They let you slice and dice vast amounts of data to create intelligent, supremely flexible summaries. Excel 2007 takes the drudgery out of creating pivot tables and makes the final results easier to read. Chapter 21 tells their story.

- **Save-as-PDF.** A PDF file is Adobe’s popular electronic document format that lets you share your work with other people, without losing any of your formatting (and without letting them change any of your numbers). Due to legal headaches, this feature didn’t quite make it into the Excel 2007 installation, but it’s available as a free download from Microsoft. Chapter 1 has the details.

Of course, this list is by no means complete. Excel 2007 is chock-full of refinements, tweaks, and tune-ups that make it easier to use than any previous version. You’ll learn all the best tricks throughout this book. And if you’ve used a previous version of Excel, look for the “Nostalgia Corner” boxes, which tell how things have changed.

**About This Book**

Despite the many improvements in software over the years, one feature hasn’t improved a bit: Microsoft’s documentation. With Office 2007, you get no printed user guide at all. To learn about the thousands of features included in this software collection, Microsoft expect you to read the online help.
Occasionally, the online help is actually helpful, like when you’re looking for a quick description explaining a mysterious new function. On the other hand, if you’re trying to learn how to, say, create an attractive chart, you’ll find nothing better than terse and occasionally cryptic instructions.

The purpose of this book, then, is to serve as the manual that should have accompanied Excel 2007. In these pages, you’ll find step-by-step instructions and tips for using almost every Excel feature, including those you may not even know exist.

**About the Outline**

This book is divided into eight parts, each containing several chapters.

- **Part 1, Worksheet Basics.** In this part, you’ll get acquainted with Excel’s interface and learn the basic techniques for creating spreadsheets and entering and organizing data. You’ll also learn how to format your work to make it more presentable, and how to create sharp printouts.

- **Part 2, Formulas and Functions.** This part introduces you to Excel’s most important feature—formulas. You’ll learn how to perform calculations ranging from the simple to the complex, and you’ll tackle specialized functions for dealing with all kinds of information, including scientific, statistical, business, and financial data.

- **Part 3, Organizing Worksheets.** The third part covers how to organize and find what’s in your spreadsheet. First, you’ll learn to search, sort, and filter large amounts of information by using tables. Next, you’ll see how to boil down complex tables with grouping and outlining. Finally, you’ll turn your perfected spreadsheets into reusable templates.

- **Part 4, Charts and Graphics.** The fourth part introduces you to charting and graphics, two of Excel’s most popular features. You’ll learn about the wide range of different chart types available and when it makes sense to use each one. You’ll also find out how you can use pictures to add a little pizzazz to your spreadsheets.

- **Part 5, Advanced Data Analysis.** In this short part, you’ll tackle some of the more advanced features that people often overlook or misunderstand. You’ll see how to study different possibilities with scenarios, use goal seeking and the Solver add-in to calculate “backward” and fill in missing numbers, and create multi-layered summary reports with pivot tables.

- **Part 6, Sharing Data with the Rest of the World.** The sixth part explores ways that you can share your spreadsheets with other people and integrate Excel with other applications. You’ll learn how to collaborate with colleagues to revise a spreadsheet, without letting mistakes creep in or losing track of who did what. You’ll also learn how to copy Excel tables and charts into other programs (like Word), extract information from a database and put it into Excel, and convert worksheets into Web pages.
Part 7, Programming Excel. This part presents a gentle introduction to the world of Excel programming, first by recording macros and then by using the full-featured VBA (Visual Basic for Applications) language, which lets you automate complex tasks.

Part 8, Appendix. The end of this book wraps up with an appendix that shows how to customize the Quick Access toolbar to get easy access to your favorite commands.

About These Arrows

Throughout this book, you'll find sentences like this one: “Choose Insert → Illustrations → Picture.” This a shorthand way of telling you how to find a feature in the Excel ribbon. It translates to the following instructions: “Click the Insert tab of the toolbar. On the tab, look for the Illustrations section. In the Illustrations box, click the Picture button.” Figure I-11 shows the button you want.

Note: As you saw back in Figure I-4, the ribbon adapts itself to different screen sizes. Depending on the size of your Excel window, it’s possible that the button you need to click won’t include any text. Instead, it shows up as a small icon. In this situation, you can hover over the mystery button to see its name before deciding whether to click it.

Contextual tabs

There are some tabs that only appear in the ribbon when you’re working on specific tasks. For example, when you create a chart, a Chart Tools section appears with three new tabs (see Figure I-12).
When dealing with contextual tabs, the instructions in this book always include the title of the tab section (it’s Chart Tools in Figure I-12). Here’s an example: “Choose Chart Tools | Design ➝ Type ➝ Change Chart Type.” Notice that the first part of this instruction includes the tab section title (Chart Tools) and the tab name (Design), separated by the | character. That way, you can’t mistake the Chart Tools | Design tab for a Design tab in some other group of contextual tabs.

**Drop-down buttons**

From time-to-time you’ll encounter buttons in the ribbon that have short menus attached to them. Depending on the button, this menu might appear as soon as you click the button, or it might appear only if you click the button’s drop-down arrow, as shown in Figure I-13.
When dealing with this sort of button, the last step of the instructions in this book tells you what to choose from the drop-down menu. For example, say you’re directed to “Home ➔ Clipboard ➔ Paste ➔ Paste Special.” That tells you to select the Home tab, look for the Clipboard section, click the drop-down part of the Paste button (to reveal the menu with extra options), and then choose Paste Special from the menu.

**Note:** Be on the lookout for drop-down arrows in the ribbon—they’re tricky at first. You need to click the arrow part of the button to see the full list of options. When you click the other part of the button, you don’t see the list. Instead, Excel fires off the standard command (the one Excel thinks is the most common choice) or the command you used most recently.

### Dialog box launchers

As powerful as the ribbon is, you can’t do everything using the buttons it provides. Sometimes you need to use a good ol’ fashioned dialog box. (A dialog box is a term used in the Windows world to describe a small window with a limited number of options. Usually, dialog boxes are designed for one task and they aren’t resizable, although software companies like Microsoft break these rules all the time.)

There are two ways to get to a dialog box in Excel 2007. First, some ribbon buttons take you there straight away. For example, if you choose Home ➔ Clipboard ➔ Paste ➔ Paste Special, you always get a dialog box. There’s no way around it.

The second way to get to a dialog box is through something called a dialog box launcher, which is just a nerdified name for the tiny square-with-arrow icon that sometimes appears in the bottom-right corner of a section of the ribbon. The easiest way to learn how to spot a dialog box launcher is to look at Figure I-14.

![Figure I-14: Dialog box launchers](image)
Introduction

When you click a dialog box launcher, the related dialog box appears. For example, click the dialog box launcher for the Font section and you get a full Font dialog box that lets you scroll through all the typefaces on your computer, choose the size and color, and so on.

In this book, there’s no special code word that tells you to use a dialog box launcher. Instead, you’ll see an instruction like this: “To see more font options, look at the Home ➝ Font section and click the dialog box launcher (the small icon in the bottom-right corner).” Now that you know what a dialog box launcher is, that makes perfect sense.

**Ordinary menus**

As you’ve already seen, the ribbon has taken the spotlight from traditional toolbars and menus. However, there are a couple of cases where you’ll still use the familiar Windows menu. One example is when you use the Visual Basic editor (in Chapter 28). In this case, the arrows refer to menu levels. For example the instruction “Choose File ➝ Save” means “Click the File menu heading. Then, on the File menu, click the Save command.”

Another example is when you use the Office menu. Instructions for the Office menu look something like this: “Choose Office button ➝ Save.” That translates to “Click the Office button in the top-left corner of the window to show the Office menu. Next, choose Save from the menu.”

**About Shortcut Keys**

Every time you take your hand off the keyboard to move the mouse, you lose a few microseconds. That’s why many experienced computer fans use keystroke combinations instead of toolbars and menus wherever possible. Ctrl+S, for example, is a keyboard shortcut that saves your current work in Excel (and most other programs).

When you see a shortcut like Ctrl+S in this book, it’s telling you to hold down the Ctrl key, and, while it’s down, press the letter S, and then release both keys. Similarly, the finger-tangling shortcut Ctrl+Alt+S means hold down Ctrl, and then press and hold Alt, and then press S (so that all three keys are held down at once).

**About Clicking**

This book gives you three kinds of instructions that require you to use your computer’s mouse or laptop’s trackpad. To **click** means to point the arrow cursor at something on the screen, and then—without moving the cursor at all—press and release the clicker button on the mouse (or laptop trackpad). To **double-click**, of course, means to click twice in rapid succession, again without moving the cursor at all. And to **drag** means to move the cursor while pressing the button continuously.
Examples

As you read this book, you’ll see a number of examples that demonstrate Excel features and techniques for building good spreadsheets. Many of these examples are available as Excel workbook files in a separate download. Just surf to www.missingmanuals.com, click the link for this book, and then click the “Missing CD” to visit a page where you can download a Zip file that includes the examples, organized by chapter.

About MissingManuals.com

At www.missingmanuals.com, you’ll find news, articles, and updates to the books in the Missing Manual series.

But the Web site also offers corrections and updates to this book (to see them, click the book’s title, and then click Errata). In fact, you’re invited and encouraged to submit such corrections and updates yourself. In an effort to keep the book as up-to-date and accurate as possible, each time we print more copies of this book, we’ll make any confirmed corrections you’ve suggested. We’ll also note such changes on the Web site, so that you can mark important corrections in your own copy of the book.

In the meantime, we’d love to hear your own suggestions for new books in the Missing Manual series. There’s a place for that on the Web site, too, as well as a place to sign up for free email notification of new titles in the series.

Safari® Enabled

When you see a Safari® Enabled icon on the cover of your favorite technology book, that means the book is available online through the O’Reilly Network Safari Bookshelf.

Safari offers a solution that’s better than e-books. It’s a virtual library that lets you easily search thousands of top tech books, cut and paste code samples, download chapters, and find quick answers when you need the most accurate, current information. Try it for free at http://safari.oreilly.com.
Part One: Worksheet Basics

Chapter 1: Creating and Navigating Worksheets
Chapter 2: Adding Information to Worksheets
Chapter 3: Moving Data Around a Worksheet
Chapter 4: Managing Worksheets and Workbooks
Chapter 5: Formatting Cells
Chapter 6: Smart Formatting Tricks
Chapter 7: Viewing and Printing Worksheets
Colophon

Marlowe Shaeffer was the production editor for *Excel 2007: The Missing Manual*. Adam Witwer provided quality control. Dawn Mann wrote the index.

The cover of this book is based on a series design originally created by David Freedman and modified by Mike Kohnke, Karen Montgomery, and Fitch (**www.fitch.com**). Back cover design, dog illustration, and color selection by Fitch.

David Futato designed the interior layout, based on a series design by Phil Simpson. This book was converted by Abby Fox to FrameMaker 5.5.6. The text font is Adobe Minion; the heading font is Adobe Formata Condensed; and the code font is LucasFont’s TheSans Mono Condensed. The illustrations that appear in the book were produced by Robert Romano and Jessamyn Read using Macromedia FreeHand MX and Adobe Photoshop CS.